<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>i</td>
<td>Indicates a hint. Is used to provide information on how to avoid operating errors or information, emphasizing important details.</td>
</tr>
<tr>
<td>▶</td>
<td>Indicates the solution of a problem. Is used to provide troubleshooting information or answers to frequently asked questions.</td>
</tr>
<tr>
<td>■</td>
<td>Indicates a list item.</td>
</tr>
<tr>
<td>✓</td>
<td>Indicates a prerequisite. Is used for a condition that has to be fulfilled before starting a particular operation.</td>
</tr>
<tr>
<td>♦</td>
<td>Indicates a one-step operation.</td>
</tr>
<tr>
<td>1 2 3</td>
<td>Indicates steps within operating sequences.</td>
</tr>
<tr>
<td>Italic</td>
<td>Is used for references and for table or figure titles.</td>
</tr>
<tr>
<td>➔</td>
<td>Is used to identify a link to related information as well as previous or next steps.</td>
</tr>
<tr>
<td>Bold</td>
<td>Is used to identify window titles, menu items, function names, buttons, and keys, for example, the Save button.</td>
</tr>
<tr>
<td>Blue</td>
<td>Is used to emphasize particularly important sections of the text.</td>
</tr>
<tr>
<td>Courier</td>
<td>Is used for on-screen output of the system including code-related elements or commands.</td>
</tr>
<tr>
<td>Courier</td>
<td>Is used to identify inputs you need to provide.</td>
</tr>
<tr>
<td>Menu &gt; Menu Item</td>
<td>Is used for the navigation to a certain submenu entry.</td>
</tr>
<tr>
<td>&lt;variable&gt;</td>
<td>Is used to identify variables or parameters, for example, within a string.</td>
</tr>
</tbody>
</table>

**CAUTION**

Used with the safety alert symbol, indicates a hazardous situation which, if not avoided, could result in minor or moderate injury or material damage. CAUTION consists of the following elements:

- Information about the nature of a hazardous situation
- Consequences of not avoiding a hazardous situation
- Methods of avoiding a hazardous situation
WARNING
Indicates a hazardous situation which, if not avoided, could result in death or serious injury.

WARNING consists of the following elements:
- Information about the nature of a hazardous situation
- Consequences of not avoiding a hazardous situation
- Methods of avoiding a hazardous situation
## 1 Introduction

- 1.1 Layout of the operator manual
- 1.2 The current operator manual
- 1.3 Intended use
- 1.4 Authorized operating personnel
  - 1.4.1 Definitions of different persons

## 2 Preparation

- 2.1 Preparing and positioning the patient
  - 2.1.1 Reducing motion artifacts
  - 2.1.2 Preparing the contrast agent injection
  - 2.1.3 Positioning the patient
    - Example: multi-station CE MRA with single injection
    - Example: multi-station CE MRA with double injection
  - 2.1.4 Preparing ECG-triggered examinations
    - Positioning the electrodes and PERU
    - Attaching ECG electrodes
    - Procurement addresses
3 Contrast-enhanced MR angiography measurements

3.1 General information
3.1.1 Timing of CA injection
   Transit time
   Data acquisition window
3.1.2 Multi-station CE MRA
   Injection strategies
3.1.3 Dynamic CE MRA
   Principle of TWIST
   Parameters under syngo
   Central region A
   Sampling density B
   Dynamic recon mode
3.1.4 Parameters under syngo
   scan@center
   Composing (Inline and Offline)
   Find Localizer
   Automatic coil selection
3.1.5 Inline post-processing
   Inline subtraction within a protocol
   Inline subtraction across several protocols
   Triggering subtraction across several protocols
   Additional Inline post-processing
3.2 Performing a test bolus CE MRA
3.2.1 Planning and measuring the test bolus
3.2.2 Determining the transit time
3.2.3 Measuring pre-contrast images
3.2.4 Measuring post-contrast images
3.3 Performing a Care Bolus CE MRA
3.3.1 Measuring pre-contrast images
   If earlier vein enhancement is expected
3.3.2 Positioning the Care Bolus slice
3.3.3 Measuring Care Bolus and post-contrast images
### 3.4 Performing a dynamic CE MRA
- **3.4.1** TWIST protocols ................................................................. 43
- **3.4.2** Setting the dynamic parameters
  - Displaying temporal information ............................................. 45
- **3.4.3** Measuring pre-contrast and post-contrast images ............. 46

### 3.5 Performing a multi-station CE MRA with single injection
- **3.5.1** Measuring the localizer ..................................................... 47
- **3.5.2** Planning and measuring pre-contrast images
  - Positioning the slices ................................................................. 48
  - Starting the measurement ......................................................... 49
- **3.5.3** Positioning the Care Bolus slice ................................. 49
- **3.5.4** Measuring the Care Bolus and post-contrast images .......... 50

### 3.6 Performing a multi-station CE MRA with double injection
- **3.6.1** Measuring the localizer ..................................................... 51
- **3.6.2** Planning and measuring pre-contrast images for the first injection
  - Positioning the slices ................................................................. 52
  - Starting the measurement ......................................................... 53
- **3.6.3** Measuring the Care Bolus and post-contrast images for the first injection ......................................................... 53
- **3.6.4** Measuring the second injection ......................................... 54

### 3.7 Angio Dot Engine
- **3.7.1** Planning the examination and measuring the localizers
  - Accessing the Patient View ......................................................... 55
  - Modifying parameters of measured protocols ............................ 56
  - Starting the measurement ......................................................... 57
- **3.7.2** Planning and measuring the test bolus ........................ 57
- **3.7.3** Planning the CE MRA measurements and measuring pre-contrast images
  - Determining the transit time ...................................................... 58
  - Positioning the slices and setting the timing parameters .......... 58
- **3.7.4** Measuring post-contrast images ...................................... 60
- **3.7.5** Configuring protocol steps (optional)
  - Configuring the bolus timing ..................................................... 62
3.8 TimCT Angio Dot Engine
   3.8.1 Measuring a large FoV localizer
   3.8.2 Measuring the vessel scout
   3.8.3 Bolus timing

4 Non-contrast-enhanced MR angiography measurements
   4.1 General information
      4.1.1 Time-of-Flight (ToF) MR angiography
         Optimal slice positioning
         Contrast optimization with TONE
         Contrast optimization through Magnetization Transfer (MTC)
         Parameters under syngo
         ECG triggering with pulsatile flow
      4.1.2 Phase-contrast MR angiography
         Parameters under syngo
         PC MRA with ECG triggering
         PC MRA with pulse triggering
      4.1.3 syngo NATIVE
         Principle of NATIVE SPACE
         Principle of NATIVE TrueFISP
   4.2 Performing a NATIVE SPACE examination of the peripheral vessels
      4.2.1 Determining the trigger times
      4.2.2 Using TD scout alternatives (optional)
         Using the NATIVE TD scout
      4.2.3 Measuring NATIVE images
   4.3 Performing a NATIVE TrueFISP examination of the renal arteries
      4.3.1 Planning the imaging volume and inversion band(s)
      4.3.2 Checking the respiratory signal
      4.3.3 Alternative examination types
         1D PACE/ECG triggering
         1D PACE/no ECG triggering
         Free breathing
## 5 Flow measurements

5.1 Measuring the flow in the renal arteries 86  
5.1.1 Measuring the localizers 86  
5.1.2 Determining the slice position 86  
5.1.3 Determining the flow sensitivity 87  
5.1.4 Performing the measurement 88

## 6 Post-processing

6.1 Statistical evaluation with Mean Curve 90  
6.1.1 Preparing the data 90  
  Loading the image data 90  
  Optimizing the image display 91  
  Determining the sorting for evaluation 91  
6.1.2 Defining the evaluation region 92  
  Searching an image for ROI positioning 92  
  Drawing ROIs 93  
  Adapting and propagating ROIs 94  
6.1.3 Performing the evaluation 94  
  Switching to relative evaluation 95  
  Starting evaluation 95  
  Optimizing the result display by scaling 96  
6.1.4 Documenting the results 97  
  Setting the background image for diagrams 97  
  Reporting the results 97
6.2 Vessel analysis with Vessel View 97
  6.2.1 Preparing the data 98
    Loading the image data 98
    Optimizing the image display 98
  6.2.2 Defining the vessel 100
    Creating the paths semi-automatically 100
    Separating the arteries from the veins 101
    Removing interfering vessels 102
  6.2.3 Analyzing the vessel 103
    Displaying the vessel in the Vessel Navigator 104
    Inspecting the vessel 104
    Evaluating stenoses 104
    Measuring the vessel geometries 106
    Sending the image data to the GSP 106
  6.2.4 Documenting the results 107
    Documenting the vessel properties 107
    Documenting the axial cuts of the vessel 107
    Saving and filming the results 108
    Reporting the results 109

6.3 Flow analysis with Argus 109
  6.3.1 Preparing the data 110
    Loading the image data 110
    Optimizing the image display 111
  6.3.2 Defining the evaluation regions 112
    Drawing the ROI for the ascending aorta 113
    Drawing the ROI for the descending aorta 113
    Analyzing low velocities (optional) 113
    Propagating the vessel contours to other cardiac phases 114
    Confirming the propagated vessel contours 114
  6.3.3 Evaluating the vessels 115
    Calculating results with standard settings 116
    Limiting the time range 116
    Performing baseline correction 117
    Correcting phase aliasing 117
1 Introduction

In order to operate the MR system accurately and safely, the operating personnel must have the necessary expertise as well as knowledge of the complete operator manual. The operator manual must be read carefully prior to using the MR system.

1.1 Layout of the operator manual

Your complete operator manual is split up into several volumes to improve readability. Each of these individual operator manuals covers a specific topic:

- Hardware components (system, coils, etc.)
- Software (measurement, evaluation, etc.)

Another element of the complete operator manual is the information provided for the system owner of the MR system.

The extent of the respective operator manual depends on the system configuration used and may vary.

All components of the complete operator manual may include safety information that needs to be adhered to.

The operator manuals for hardware and software address the authorized user. Basic knowledge in operating PCs and software is a prerequisite.

1.2 The current operator manual

This manual may include descriptions covering standard as well as optional hardware and software. Contact your Siemens Sales Organization with respect to the hardware and software available for your system. The description of an option does not infer a legal requirement to provide it.
The graphics, figures, and medical images used in this operator manual are examples only. The actual display and design of these may be slightly different on your system.

Male and female patients are referred to as “the patient” for the sake of simplicity.

1.3 Intended use

Your MAGNETOM MR system is indicated for use as a magnetic resonance diagnostic device (MRDD) that produces transverse, sagittal, coronal and oblique cross sectional images, spectroscopic images and/or spectra, and that displays the internal structure and/or function of the head, body, or extremities. Other physical parameters derived from the images and/or spectra may also be produced.

Depending on the region of interest, contrast agents¹ may be used. These images and/or spectra and the physical parameters derived from the images and/or spectra when interpreted by a trained physician yield information that may assist in diagnosis.

¹ The drugs mentioned herein shall be used consistent with the approved labeling and/or indications for use of the drug. The treating physician bears the sole responsibility for the diagnosis and treatment of patients, including drugs and doses prescribed in connection with such use.

Your MAGNETOM MR system may also be used for imaging during interventional procedures when performed with MR compatible devices such as in-room displays and MR Safe biopsy needles.

The MAGNETOM MR system is not a device with measuring function as defined in the Medical Device Directive (MDD). Quantitative measured values obtained are for informational purposes and cannot be used as the only basis for diagnosis.

For the USA only: Federal law restricts this device to sale, distribution and use by or on the order of a physician.
Your MR system is a medical device for human use only!

1.4 Authorized operating personnel

The MAGNETOM MR system must be operated according to the intended use and only by qualified persons with the necessary knowledge in accordance with country-specific regulations, e.g. physicians, trained radiological technicians or technologists, subsequent to the necessary user training.

This user training must include basics in MR technology as well as safe handling of MR systems. The user must be familiar with potential hazard and safety guidelines the same way the user is familiar with emergency and rescue scenarios. In addition, the user has to have read and understood the contents of the operator manual.

Please contact Siemens Service for more information on available training options and suggested duration and frequency of such training.

1.4.1 Definitions of different persons

<table>
<thead>
<tr>
<th>Term used</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>User/Operator/Operating personnel</td>
<td>Person who operates the system or software, takes care of the patient or reads images</td>
</tr>
<tr>
<td></td>
<td>Typically physicians, trained radiological technicians, or technologists</td>
</tr>
<tr>
<td>System owner</td>
<td>Person who is responsible for the MR environment. This includes legal requirements, emergency plans, employee information and qualifications, as well as maintenance/repair.</td>
</tr>
</tbody>
</table>
### Introduction

<table>
<thead>
<tr>
<th>Term used</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>MR worker</td>
<td>Person who works within the controlled access area or MR environment&lt;br&gt;Operator as well as further personnel (for example, cleaning staff, facility manager, service personnel)</td>
</tr>
<tr>
<td>Siemens Service/service personnel</td>
<td>Group of specially trained persons who are authorized by Siemens to perform certain maintenance activities&lt;br&gt;References to “Siemens Service” include service personnel authorized by Siemens.</td>
</tr>
</tbody>
</table>
2 Preparation

2.1 Preparing and positioning the patient
2.1 Preparing and positioning the patient

In what follows, patient preparation for contrast agent measurements is described.

**USA only:** Please note, that currently the indication is limited to aorto-iliac MR Angiography (MRA).

2.1.1 Reducing motion artifacts

1. Instruct the patient to hold completely still during the entire examination.
2. Instruct the patient to take shallow and gentle breaths during the measurements.

2.1.2 Preparing the contrast agent injection

**Prior** to moving the patient table into the magnet, you route the tube for the infusion.

1. Insert an intravenous port into the forearm vein of the patient.
2. Connect the port to the extension tube.

**Note:** The tube should be long enough so that it can be accessed from the outside when the patient is in the magnet bore.

3. Connect the tube to the contrast agent injector.

2.1.3 Positioning the patient

- **✓** Port for contrast agent application has been inserted

**Example:** multi-station CE MRA with single injection

1. Position the patient feet first.
2. To suppress patient movements, position the patient as comfortably as possible using suitable positioning aids.
3. Center the light localizer to max. 1/2 FoV above the feet.
Possible coils: Body 18 (2–3) depending on the size of the patient, Spine 32, Peripheral Angio 36

Example: multi-station CE MRA with double injection

1 Position the patient head first.

2 To suppress patient movements, position the patient as comfortably as possible using suitable positioning aids.

3 Center the light localizer to max. 1/2 FoV above the feet.
Possible coils: Head Neck 20, Body 18 (2–3) depending on the size of the patient, Spine 32, Peripheral Angio 36

2.1.4 Preparing ECG-triggered examinations

Positioning the electrodes and PERU

**Electrodes:** Positioning of the electrodes varies according to the position of the heart. An example is provided in the figure below.

Use only disposable ECG electrodes as released by Siemens. (→ Page 22 *Procurement addresses*)

**PERU:** The ECG sensor in the PERU ensures transfer of the ECG signal. Typically, the PERU is aligned in the direction of the foot end of the patient table even though the patient may be positioned feet first in the direction of the magnet bore.

- Position the PERU in the appropriate support or add absorbent material between the ECG cables, PERU and skin. The distance between PERU and patient should be at least 2 cm.
Positioning the ECG electrodes (left) and the PERU (right).

The transmitter unit of the PERU includes three LEDs for signaling the battery status and one LED as fault indicator (e.g. insufficient skin contact of the ECG electrodes).

Battery status and electrode fault are also indicated on the Dot display above the magnet bore and the Physiological Display dialog window.

If the red LED Electrode fault on the PERU flashes, the ECG electrodes are not attached correctly. Check to ensure that the electrodes are not falling off.

Attaching ECG electrodes

The electrodes must be positioned and attached with care to ensure a sufficient and consistent ECG signal.

1 Discuss the breathholds and respective commands with the patient.

2 Ensure satisfactory contact between the electrodes and the patient's skin.

3 Thoroughly clean the patient's skin with a dry cloth or NUPREP ECG & EEG Abrasive Skin Prepping Gel. (→ Page 22 Procurement addresses)

4 If the patient is hirsute, shave the location where you want to attach the electrodes.

5 Dry the skin carefully.

6 Check the signal at the Dot display above the magnet bore.
7 If the signal received is not satisfactory and consistent, vary the location of the electrodes. Use new electrodes every single time.

8 If one of the leads does not provide a sufficient signal, change to a single ECG lead in the Physiological Display dialog window.

Procurement addresses

**Disposable ECG electrodes** may be ordered from:

Siemens Commercial goods (Catalog Med & More), CONMED 2700 Cleartrace

- Item no. 07437598 (600 pieces)

or from:

CONMED CORPORATION, 310 Broad Street, Utica, New York 13501, USA

**Cleaning gel:** NUPREP ECG & EEG Abrasive Skin Prepping Gel

Weaver and Company, 565 Nucla Way, Unit B, Aurora, Colorado 80011, USA
3 Contrast-enhanced MR angiography measurements

3.1 General information 24
3.2 Performing a test bolus CE MRA 36
3.3 Performing a Care Bolus CE MRA 40
3.4 Performing a dynamic CE MRA 43
3.5 Performing a multi-station CE MRA with single injection 47
3.6 Performing a multi-station CE MRA with double injection 51
3.7 Angio Dot Engine 55
3.8 TimCT Angio Dot Engine 62
3.1 General information

To increase the signal of the blood, CE MRA uses the effects of contrast agents (CA) to shorten T1. The contrast agent is injected intravenously. The measurement is performed while the contrast agent is predominately in the arteries. Prior to contrast administration, pre-contrast images are generated for subsequent subtraction, if necessary.

USA only: Please note, that currently the indication is limited to aorto-iliac MR Angiography (MRA).

3.1.1 Timing of CA injection

In CE MRA, the exact timing of CA injection, i.e., the synchronization of contrast administration and data acquisition, plays an essential role. If you measure too early, the contrast agent has not yet arrived in the vessel section to be examined. If you measure too late, the contrast agent has already passed through the vessel section and is diluted too much throughout the bloodstream.

Goals:

- The contrast bolus passes the FoV during data acquisition. In particular, the acquisition of the central k-space lines (which determines image contrast) should fall within the maximum CA bolus.

- To avoid venous overlay, data acquisition has to be completed before the contrast bolus reaches the venous system.

Transit time

The transit time is the time required for the bolus to move from the point of injection to the vascular target structure. This time can vary greatly as a function of the heart rate and ejection fraction.

Test bolus: As proven in clinical routine, the physiological transit time of contrast agent can be established by administering a small test bolus and determining its arrival time under fluoro.
Data acquisition window
The data acquisition window determines the measurement duration between arterial and venous enhancement. The length of the data acquisition window is contingent on the physiology present and depends especially on the vessel region under examination.

3.1.2 Multi-station CE MRA

Injection strategies
Two different injection strategies can be used with multi-station MRA.

- Single injection: All stations are measured, one after the other, directly after the contrast agent bolus.
  - Advantages: Fast and simple
  - Disadvantages: Optimal timing is not always ensured, especially at the lower stations
  - Example: Multi-station CE MRA with single injection
    (+ Page 47 Performing a multi-station CE MRA with single injection)

- Double injection: The individual stations are distributed across two injections.
  - Advantages: Optimal timing for each level
  - Disadvantages: Somewhat more time-consuming
  - Example: Multi-station CE MRA with double injections
    (+ Page 51 Performing a multi-station CE MRA with double injection)

3.1.3 Dynamic CE MRA

During dynamic CE MRA with syngo TWIST, a series of 3D data sets is acquired during the CA passage.

Advantages:
- Very good image quality, even during quick, dynamic changes in signal
- No venous overlay
- Very good results even with low CA doses
No need for a test bolus or any other kind of bolus timing

Complete support of the entire FOV

Fully compatible with GRAPPA and iPAT²

**Principle of TWIST**

The display of dynamic procedures requires high temporal resolution, that is, short measurement times. During data acquisition, the k-space can be manipulated to reduce the measurement time.

TWIST divides the k-space into two areas that are sampled at different rates.

- Central k-space lines (A), determining the image contrast
- Outer k-space lines (B), determining the spatial resolution

(1) Complete sampling of the entire k-space

(2) Example TWIST: complete sampling of the central lines (A). The sampling density of the outer lines (B), is, e.g., 33%. Images are computed each time A is sampled.

**Parameters under syngo**

All TWIST-specific parameters are located on the Angio Common parameter card.
Central region A
Percentage of central k-space lines filled per measurement.

Sampling density B
Percentage of outer k-space lines filled per measurement (0% = keyhole examination).

Dynamic recon mode
Type of k-space reconstruction used for multiple measurements.
**Forward share:** Complete k-space is sampled at the beginning of the measurement, forwarding of data acquired in region B to the **following** images.

**Symmetric share:** Complete k-space is always sampled both at the beginning and at the end of the measurement.

**Backward share:** Complete k-space is sampled at the end of the measurement, transferring of data acquired in region B to the **preceding** images.
Keyhole examination: Prerequisite is a sampling density $B = 0$. Requires “Backward share” as the reconstruction mode.

3.1.4 Parameters under *syngo*

scan@center

The positioning mode ISO is the **default** for all CE MRA protocols.
**3 Contrast-enhanced MR angiography measurements**

**Advantage:** The maximum FoV can be fully used, since the measurements are taken in the magnet isocenter.

**Composing (Inline and Offline)**

Can be used for:
- Single localizer stations (composed images can be subsequently used as reference images for slice positioning)
- Subtraction images of individual stations
- MIP reconstructions of individual stations
Find Localizer

The **Find Localizer** function is located in the context menu of the graphic segments or in the **Scroll > Find Localizer** menu.

When calling the function, a series is loaded into graphic slice positioning which corresponds to the table position of the open protocol.

**Automatic coil selection**

All coils are automatically selected in the area of the planned FoV. You are able to manually correct the coil selection. To switch the automatic coil selection on or off, select the **Queue > Auto Coil Select** menu.

3.1.5 **Inline post-processing**

Different post-processing routines are included on the **Angio Inline** parameter card.

**Inline subtraction within a protocol**

Subtraction is performed within **one** protocol. For this purpose you define a measurement as a subtrahend. It will be subtracted from all measurements following the subtrahend.

For **Inline subtraction within a protocol**, the number of measurements must be > 1.

Example:
Subtrahend = 3.

Beginning with the fourth measurement, the series of the third measurement is subtracted from all measured series.

As result series you obtain:

- Original images
- Subtraction series

This subtraction mode should be preferred for dynamic examinations or breast examinations.

Further parameters:

- **Subtraction indices**: Allows the specification of which measurements are taken into account (list separated by commas, e.g., 1,3,5).

- **Std-Dev-Sag/-Cor/-Tra**: Spatial standard deviation along the 3 axis identical to Dynamic Analysis. This type of post-processing is used in preference for fat-suppressed or subtracted datasets. (Prerequisite: StdDev checkbox is activated.)

- **Std-Dev-Time**: Standard deviation over time as used, for example, for triggered multi-phase PC protocols to obtain the criterion for pulsatile or laminar flow in the result image. (Prerequisite: StdDev checkbox is activated.)
Inline subtraction across several protocols

Example: Performing subtractions across several protocols with just one measurement per protocol.

Number of measurements (before and after contrast) = 1, Subtrahend = 1.

Use this subtraction mode for multi-station programs where several pre-contrast agent series for different table positions are stored intermediately.

Example: Performing subtraction across several protocols.
Number of measurements before contrast = 1, after contrast > 1, Subtrahend = –1.

Subtrahend = –1 means: Subtraction is not performed within the post-contrast measurement, but rather the pre-contrast measurement is subtracted from all post-contrast measurements.

You may want to use this subtraction mode in the last station for the region of the feet.

**Triggering subtraction across several protocols**

The **Patient has contrast agent** checkbox is the trigger for starting subtraction.
As long as the checkbox is **not** selected, the measured series is temporarily stored in the image processor.

If a protocol is measured for a second time without selecting the checkbox, it will overwrite the previous one.

After selecting the checkbox, the subtraction mode is active and the syringe symbol is superposed in the measurement queue. The images acquired prior to selecting the checkbox are subtracted from the subsequent measurements.

After completing the angio measurements you are able to perform manual subtraction of the post-contrast and pre-contrast series.

**Additional Inline post-processing**

Additional post-processing functions are integrated on the **Angio MIP** parameter card. The post-processing steps are either used for original data or for subtracted data.
The following Inline post-processing functions are possible:

- **MIP-Sag/-Cor/-Tra**: Spatial MIP computation in the three orthogonal directions of a 3D data set.

- **MIP-Time**: Temporal MIP computation that can be used as well across the phases for triggered multi-phase measurements. With a dynamic test bolus (2D and 3D), it is also possible to generate one image that displays the entire information of a series over time.

### 3.2 Performing a test bolus CE MRA

Test bolus programs use a test bolus to ensure optimal timing between injection and starting the measurement. Subsequently, a pre and a post-contrast measurement are performed.

#### 3.2.1 Planning and measuring the test bolus

Prior to the actual 3D CE MRA data acquisition, you inject a small amount of contrast agent at the same injection rate as for CE MRA. A rapid 2D measurement, typically 40–80 images with a temporal resolution of one image per second, is used to view the passage of the test bolus in the vicinity of the target vessel.

- ✓ Localizer has been measured
- ✓ Contrast injector is ready
- ✓ Injection scheme has been determined

1. Select the test bolus protocol.
2. Position the test bolus slice so that the vessels of interest are completely covered.
3. Start the test bolus measurement and simultaneously inject the contrast agent.
4. Use the same injection scheme as that used subsequently with the actual CE MRA.

The test bolus images are displayed.
3.2.2 Determining the transit time

For proper determination of the transit time, you start the test bolus measurement at the same time as the injection. For each frame, the time after start of the measurement will be displayed as time-to-center (TTC) in the image comment field at the bottom of the image segment.

If a temporal resolution of 1 s per image is chosen for the test bolus protocol, the time that has elapsed since the injection can also be determined from the image number.

- The image number of the image that shows full intensity corresponds to the transit time in seconds.

- Determine the transit time from the TTC displayed as a comment at the bottom of the test bolus images.

Use Mean Curve for a more exact evaluation. Use the time when the curve reaches half its maximum value as the transit time. This evaluation is especially suitable when the temporal resolution is not equal to a second (e.g., when examining a hand) and/or when triggered measurements are used, since the temporal resolution between images varies somewhat.

(⇨ Page 90 Statistical evaluation with Mean Curve)

3.2.3 Measuring pre-contrast images

- Test bolus has been measured
- Transit time has been determined

1 Select the pre-contrast protocol.

The Exam paused dialog window opens.
2 Ensure that the Patient has contrast agent checkbox is not selected for the first pre-contrast measurement. In this way you determine that the measurement will be used as a mask for the post-contrast series.

3 Start the pre-contrast measurement with Continue.

### 3.2.4 Measuring post-contrast images

- Contrast injector is ready
- Injection scheme has been determined
- Pre-contrast images have been measured

1 Select the post-contrast protocol.

To ensure that the post-contrast images are measured identically to the pre-contrast images, the copy reference of the post-contrast protocol is activated (option Everything).

The Exam paused dialog window opens.
2 Select the **Patient has contrast agent** checkbox.

You are able to enter additional details for the examinations (e.g., CA used) by clicking the syringe symbol.

3 Select the stopwatch symbol.

4 Enter the desired measurement delay (e.g. 20 s) into the countdown timer.

If you are using automatic speech commands, you have to subtract the duration of the command from the measurement delay to ensure correct timing.
5 Start the injection simultaneously with the countdown timer by clicking Start.

The countdown timer counts down to zero.

As soon as the countdown timer reaches zero:

6 Start the post-contrast measurement with Continue.

The timer does not begin the measurement automatically. If the measurement is not begun after the timer reaches zero (0), the timer will display a negative time.

The post-contrast and subtraction images are displayed.

3.3 Performing a Care Bolus CE MRA

Using the Care Bolus program, you are able to depict the arrival of the contrast agent in the anatomical area of interest using “MR Fluoroscopy” (Inline Display) and immediately start a 3D measurement. The Care Bolus technique combines the determination of the transit time with the actual CE MRA.

3.3.1 Measuring pre-contrast images

✓ Localizer has been measured

1 Select the pre-contrast protocol.

The Exam paused dialog window opens.
2 Ensure that the **Patient has contrast agent** checkbox is **not** selected for the first pre-contrast measurement. In this way you determine that the measurement will be used as a mask for the post-contrast series.

**If earlier vein enhancement is expected**

1 Open the **Angio Common** parameter card.

![Angio Common parameter card](image)

2 Activate the **3D centric reordering** checkbox.

3 Enter the measurement time of the center of the k-space (**Time to center**).

4 In the **Exam paused** dialog window: Start the pre-contrast measurement with **Continue**.

All necessary adjustments are performed and saved. They can be restored very quickly for the repeat measurement.

---

**For this reason, always perform a pre-contrast measurement even though you may not use this data for a subtraction mask subsequently.**

### 3.3.2 Positioning the Care Bolus slice

You use the Care Bolus protocol to monitor the contrast agent inflow in real time on the Inline Display.
✓ Pre-contrast images have been measured

1 Select the Care Bolus protocol.

The Exam paused dialog window opens.

2 Activate the Patient has contrast agent checkbox.

3 Position the Care Bolus slice so that the vessels of interest are fully within the slice.

You are able to select slice thicknesses of up to 8 cm to ensure full acquisition of the vessels as the contrast bolus passes through them.

Even though the scan@center functionality is used, the table may not move between the Care Bolus and the post-contrast measurement to avoid a time delay. This is ensured by a copy reference (Table position) of the Care Bolus protocol on the pre-contrast measurement.

3.3.3 Measuring Care Bolus and post-contrast images

✓ Care Bolus slice has been positioned

1 In the Exam paused dialog window: Start the Care Bolus measurement with Continue.

2 Open the Inline display.

After approx. 3 s an image of the 2D series appears continuously.

3 Begin with the CA injection as soon as the second image appears.
While the bolus is passing through the 2D slice:

4 Stop the Care Bolus measurement in progress and start the 3D post-contrast measurement with Stop/Continue on the Inline Display.

To ensure that the post-contrast images are measured identically to the pre-contrast images, the copy reference of the post-contrast protocol is activated (option Everything).

3.4 Performing a dynamic CE MRA

To obtain information about the dynamics of contrast agent inflow, you measure several 3D data sets (1 protocol with several measurements) quickly one after the other (1–5 s per measurement). The temporal information is obtained at the expense of spatial resolution.

You need a relatively small amount of contrast agent for dynamic CE MRA. This is why you can perform it before a high-resolution CE MRA.

The dynamic information from the TWIST examination can be used for bolus timing.

3.4.1 TWIST protocols

“Test Bolus” protocol:

- Application: 3D test bolus, for assessment of contrast dynamics
- Default orientation sagittal, but can also be used in coronal or transverse orientation
- Reconstructed voxel size: approx. 1 mm × 1 mm × 7 mm
- Temporal resolution: approx. 1 s
- Original 3D series are not saved
Subtracted MIP series is saved with timing information

Additional temporal MIP can be loaded directly into graphic slice positioning for positioning further measurements

“Dynamic” protocol:

- Application: Dynamic CE MRA, with a focus on robustness and high in-plane resolution, but lower resolution in partition direction
- Coronal orientation
- Reconstructed voxel size: approx. 1 mm × 1 mm × 2.5 mm
- Temporal resolution: between below 2 s and 3 s, depending on the system type
- All series are saved for additional post-processing

“Multiphase” protocols:

- Application: Multiphase CE MRA, aiming at high spatial and temporal resolution
- Coronal or sagittal orientation
- Reconstructed voxel size: between 1 mm and 1.3 mm, depending on the body region and system type
- Temporal resolution: depending on the body region and system type
- All series are saved for additional post-processing

3.4.2 Setting the dynamic parameters

- Localizer has been measured
- Dynamic protocol has been opened

1. Open the Angio Common parameter card.
2 Set the desired parameters. (For a detailed description, refer to: ).

By varying the percentage sizes of **Central region A** and **Sampling density B**, you can vary the contrast or resolution of the data set to a large extent.

**Displaying temporal information**

You are able to display the temporal course of the overall measurement.

- Open the corresponding tool tip by moving the mouse pointer across the overall measurement time.

The start and end time for each measurement and the time-to-center are displayed.
3.4.3 Measuring pre-contrast and post-contrast images

Since the transit time is not determined, you can start the measurement and administer the contrast agent nearly simultaneously—depending on the selected measurement region.

1. Select the dynamic protocol.
   
   The Exam paused dialog window opens.

2. Select the Patient has contrast agent checkbox.

3. Inject the contrast agent.

4. Start the measurement with Continue.
The first measurement corresponds with the pre-contrast measurement, all subsequent measurements are post-contrast measurements.

3.5 Performing a multi-station CE MRA with single injection

You use the programs for multi-station CE MRA with single injections to examine the region of interest with automatic table movement and continuous contrast agent administration. This reduces both the measurement time and the amount of contrast agent used.

For an example on how to position the patient, please refer to (→ Page 18 Example: multi-station CE MRA with single injection).

Set-n-Go protocols: Set-n-Go-protocols are part of the Tim Planning Suite. They combine several individual and aligned protocols (steps) into one program step. This allows you to conveniently measure large examination regions. You can open the steps together in a Set-n-Go Protocol, plan different table positions and display them at the same time during graphic slice positioning.

3.5.1 Measuring the localizer

You measure the localizer at three different table positions (stations I, II, III).

Set-n-Go localizer: The localizer contains all stations in one program step. After the measurement has started, one protocol is generated per station in the measurement queue (e.g., 2.1, 2.2, 2.3).

✓ Patient has been registered

◆ Load the desired program.

The localizers are measured automatically across all three stations. The table is moved automatically between the three stations. The localizer images of the first station are displayed.

3.5.2 Planning and measuring pre-contrast images

Initially, you plan and measure 3D pre-contrast images. They are performed, one after the other, for all table positions.
Pre-contrast measurement as a Set-n-Go protocol: The pre-contrast measurements are included in a program step. All stations are shown simultaneously in a composed image and can be positioned accordingly.

✓ Localizers have been measured

1 Select the pre-contrast protocol.

The Exam paused dialog window opens.

2 Ensure that the Patient has contrast agent checkbox is not selected for the first pre-contrast measurement. In this way you determine that the measurement will be used as a mask for the post-contrast series.

Positioning the slices

1 Load a localizer series that corresponds to the table position of the open protocol (right mouse-click in GSP: Find Localizer).

2 Position the slices from the 3D protocol on the allocated localizer images.

Inline Composing: You can also position the slices on the composed localizer image.

To keep the measurement time as short as possible, use a thin 3D slab for planning the pre-contrast series. To reduce the slab thickness, change the Slices per slab parameter. If the 3D slab is too thin, increase the partition thickness to ensure that the measurement time is not prolonged.
Example: Slice positioning, second station.

Starting the measurement

- In the Exam paused dialog window: Start the pre-contrast measurement with Continue.

The individual stations are measured followed by subsequent table movement.

3.5.3 Positioning the Care Bolus slice

The Care Bolus measurement is now performed. One single, relatively thick slice in the abdomen is dynamically monitored at high temporal resolution.
3 Contrast-enhanced MR angiography measurements

✓ Pre-contrast images have been measured
✓ Care Bolus protocol has been selected
◆ Position the Care Bolus slice in the paracoronal direction so that the slice fully encloses the descending aorta.

For additional information about positioning the Care Bolus slice: (→ Page 41 Positioning the Care Bolus slice).

3.5.4 Measuring the Care Bolus and post-contrast images

✓ Care Bolus slice has been positioned

1 In the Exam paused dialog window: Start the Care Bolus measurement with Continue.

2 Open the Inline display.
   After approx. 3 s, an image of the 2D series appears continuously.

3 Begin with the CA injection as soon as the second image appears.

4 Use a bi-phasic injection pattern.
   While the bolus is passing through the 2D slice:

5 Stop the Care Bolus measurement in progress and start the 3D post-contrast measurement with Stop/Continue at the Inline Display.

To ensure that the post-contrast images are measured identically to the pre-contrast images, the copy reference of the post-contrast protocol is activated (option Everything).
6  At the same time, provide the patient with breathing commands.

**Inline Composing**: The series of the last station includes an additionally composed image of subtractions and MIP reconstructions.

### 3.6 Performing a multi-station CE MRA with double injection

With programs for a multi-station CE MRA with double injection, the individual stations are segmented across two injections. During the first injection, the first part of the region of interest, during the second injection, the second part of the region of interest is measured.

For an example on how to position the patient, please refer to (→ Page 19 *Example: multi-station CE MRA with double injection*).

#### 3.6.1 Measuring the localizer

You measure the localizer at several different table positions.

**Inline Composing** is automatically selected for measuring localizers if the system has the necessary license. The images of individual protocols are automatically composed into an overall image.

- ✔ Patient has been registered
- ✦ Load the desired program.

The localizers are measured automatically. The table is moved automatically. The localizer images of the first station are displayed.
3.6.2 Planning and measuring pre-contrast images for the first injection

Initially, you plan and measure 3D pre-contrast images of the first and fourth station. They are performed, one after the other, for these two table positions.

✓ Localizers have been measured

1 Select the pre-contrast protocol.

The Exam paused dialog window opens.

2 Ensure that the Patient has contrast agent checkbox is not selected for the first pre-contrast measurement. In this way you determine that the measurement will be used as a mask for the post-contrast series.

Positioning the slices

1 Load a localizer series that corresponds to the table position of the open protocol (right mouse-click in GSP: Find Localizer).

2 Position the slices from the 3D protocols on the allocated localizer images.

Inline Composing: You can also position the slices on the composed localizer image.

Overlapping: When planning the slices, ensure that the middle stations are not shifted in the head-foot direction. This ensures sufficient overlapping with the adjacent regions.
To keep the measurement time as short as possible, use a thin 3D slab for planning the pre-contrast series. To reduce the slab thickness, change the parameter *Slices per slab*. If the 3D slab is too thin, increase the partition thickness to ensure that the measurement time is not prolonged.

Starting the measurement

- In the **Exam paused** dialog window: Start the pre-contrast measurement with **Continue**.

  The individual stations are measured followed by subsequent table movement.

### 3.6.3 Measuring the Care Bolus and post-contrast images for the first injection

- Care Bolus slice has been positioned (→ Page 41 *Positioning the Care Bolus slice*)

1. Simultaneously start the Care Bolus protocol and the contrast agent injection.

A copy reference with respect to the table position of the pre-contrast head measurement ensures that the table does not move between the Care Bolus and the post-contrast measurement.

After approx. 3 s, an image of the 2D series is displayed continuously.

2. Record the time from the start of the contrast agent injection until the contrast's arrival in the thoracic aorta.

   While the bolus is passing through the 2D slice:

3. Stop the Care Bolus measurement in progress and start the 3D post-contrast measurement with **Stop/Continue** at the Inline Display.

4. Provide the patient with breathing commands at the same time.

5. As additional timing for the measurement of the second injection, use the recorded time plus a small addition.
To ensure that the post-contrast images are measured identically to the pre-contrast images, the copy reference of the post-contrast protocol is activated (options: **Everything** and **Ignore measurements**).

6 In the **Exam paused** dialog window: Deselect the **Patient has contrast agent** checkbox!

   If this is not done, subtractions for the following measurements for the second injection cannot be performed.

### 3.6.4 Measuring the second injection

Prior to the measurements for the second injection, you have to deselect the **Patient has contrast agent** checkbox. Subsequently plan and measure the 3D pre-contrast images for the second injection. They are performed, one after the other, for all table positions.

✓ 1st injection has been measured

1 Position the slices from the 3D protocols on the allocated localizer images.

2 Check the anatomic coverage.

Overlapping: When planning the slices, ensure that the middle stations are not shifted in the head-foot direction. This ensures sufficient overlapping with the adjacent regions.

3 Start the pre-contrast measurements.

   The individual stations are measured followed by subsequent table movement.

4 After all masks have been recorded, you have to select the **Patient has contrast agent** checkbox to obtain subtractions for the post-contrast measurements.

5 Select the stopwatch symbol.

6 Enter the desired measurement delay (e.g. 20 s) into the countdown timer.
7 Start the injection simultaneously with the countdown timer by clicking **Start**.

The countdown timer counts down to zero.

As soon as the countdown timer reaches zero:

8 Start the post-contrast measurement with **Continue**.

9 Provide the patient with breathing commands at the same time.

**Inline Composing:** The series of the last station includes an additionally composed image of subtractions and MIP reconstructions.

### 3.7 Angio Dot Engine

The **Angio Dot Engine** provides a simplified workflow for CE MRA with interactive **Mean Curve** evaluation and visual timing feedback during the setup of the MRA protocol.

**i** The Dot Engine user interfaces shown in this operator manual are examples only. The actual guidance texts and the design may be slightly different on your system.

#### 3.7.1 Planning the examination and measuring the localizers

- Patient has been registered

- **Angio Dot Engine** has been selected

After registration, the **Patient View** opens automatically. The default examination parameters are loaded.
If you want to use **Automatic breath-hold commands** throughout the whole examination, activate the checkbox and set the timing and language for the commands.

You are also able to set the breathhold commands individually for each protocol (in the **Step properties** dialog window).

### Accessing the Patient View

You can access the **Patient View** at any time during the examination.

1. To open the view, click the icon.
2. To confirm the settings and close the view, click the icon.

### Modifying parameters of measured protocols

Changes in the **Patient View** only apply to pending protocols in the measurement queue.

1. To change the status of a protocol from measured to pending, select the measured protocol.
2. Select **Rerun from here** from the context menu (right-click with the mouse)
3 Open the **Patient View**.

– or –

Select **Rerun from here with** from the context menu (right-click with the mouse).

The **Patient View** opens automatically.

4 Enter the requested modifications.

**Starting the measurement**

- Confirm the patient-specific settings.

The localizers and vessel scout are acquired and displayed automatically. The test bolus protocol opens.

**3.7.2 Planning and measuring the test bolus**

**Test bolus:** Prior to the actual 3D CE MRA data acquisition, you inject a small amount of contrast agent at the same injection rate as for CE MRA. A rapid 2D measurement, typically 40–80 images with a temporal resolution of one image per second, is used to view the passage of the test bolus in the vicinity of the target vessel.
✓ Localizers have been measured
✓ Contrast injector is ready
✓ Injection scheme has been determined

1 On the localizer and the vessel scout: Position the test bolus slice so that the vessels of interest are completely covered (below the carotid bifurcation).

2 Complete the slice positioning.
   The Exam paused dialog window opens.

3 Start the test bolus measurement with Continue and simultaneously inject the contrast agent.

4 Use the same injection scheme as that used subsequently with the actual CE MRA.
   The test bolus images are displayed. The pre-contrast protocol opens.

3.7.3 Planning the CE MRA measurements and measuring pre-contrast images

Determining the transit time
To determine the transit time, you draw two regions of interest (ROI) in an artery and in a vein of the test bolus images. The signal-time curves for the arterial and venous phase are subsequently computed.
Test bolus images have been measured
Pre-contrast protocol has been opened

1. Scroll through the test bolus series and select a suitable test bolus image.
2. Draw an ROI by clicking on an artery.

You will find an example of ROI positioning by clicking the more... button.

The signal-time curve for the arterial phase is computed and displayed. In addition, the system makes a proposal for the correct position of the data acquisition window.

For a description of configuring the bolus timing, please refer to: (→ Page 62 Configuring the bolus timing)

   The signal-time curve for the venous phase is computed and displayed.
The quality of the curves depends on the physiology of the individual patient. If the curves are not satisfactory, simply draw new ROIs.

Positioning the slices and setting the timing parameters

You position the 3D slab for the following 3D measurements. You also adjust the parameter for CA timing (data acquisition window, acquisition time of the center of k-space) by moving it with the mouse.

✓ Transit time has been determined

(1) Data acquisition window
(2) Acquisition time of the center of the k-space
(3) Duration of voice commands
1 If necessary, adapt the position of the data acquisition window in relation to the curves by moving it with the mouse.

2 Check for optimal vessel contrast (the center of the k-space is acquired at maximum vessel contrast). You may adapt the acquisition time by moving the line with the mouse.

3 Check the duration of the automatic breathhold command (if selected in the Patient View).

4 Position the slab for the 3D pre-contrast and post-contrast measurements.

5 Complete the planning.

6 In the Exam paused dialog window: Start the pre-contrast measurement with Continue.

7 Ensure that the Patient has contrast agent checkbox is not selected for the pre-contrast measurement. In this way you determine that the measurement will be used as a mask for the post-contrast series.

If selected, breathhold commands are output before and after the measurement. The pre-contrast images are displayed.

### 3.7.4 Measuring post-contrast images

- Transit time has been determined
- Pre-contrast images have been measured
- Contrast injector is ready
- Injection scheme has been determined

1 To ensure that the measurement of the post-contrast images starts automatically, select the Auto Start checkbox in the Step Properties dialog window. (For a detailed description of the Auto Start feature, please refer to: Operator Manual – Scanning and postprocessing.)

2 In the Exam paused dialog window: Select the Patient has contrast agent checkbox.

The transit time determined in the previous step is preset as the measurement delay in the countdown timer.
3 Start the injection simultaneously with the countdown timer by clicking Start.

The countdown timer counts down and triggers the automatic breathhold commands (if selected), as well as the start of the post-contrast measurement.

The post-contrast and subtraction images are displayed.

### 3.7.5 Configuring protocol steps (optional)

**Dot Engine Step:** The Dot Engine Step defines which strategies, decisions and global parameters are valid for the complete Dot Engine workflow examination. For a detailed description, please refer to: Operator Manual – Dot Cockpit.

**Dot add-ins:** Dot add-ins are predefined add-ins for Dot Engine Steps and program steps. Depending on the selected Dot add-in, you can configure different parameters of the Dot Engine Step.

Configuring the bolus timing

Using the Bolus Timing Dot add-in you can set the position of the acquisition window and the display of the vessel time curves.

- Set the **Timing Offset** to 0 s, to position the data acquisition window so that the center of the k-space is acquired at the peak of the arterial phase.

If you set the **Timing Offset** for example to 3 s, then the data acquisition window is shifted accordingly.

- Select **Smoothing**, to interpolate the data points of the time curves in the display.

**Setting the acquisition window**

On update of the arterial signal-time curve, the system adapts the position of the data acquisition window relative to the signal-time curve.

**Setting the display of vessel time curves**

- Select **Smoothing**, to interpolate the data points of the time curves in the display.

### 3.8 TimCT Angio Dot Engine

Based on the Angio Dot Engine workflow an examination with continuous table movement (TimCT) is available.
TimCT enables examinations of large body areas with continuous table movement. That is, measurement pauses are avoided to reposition the patient table between successive measurements. In addition, a uniform image quality in the direction of the table move is achieved.

The table movement renders some conventional settings unsuitable. These include, e.g., multiple averages and angling the slab with respect to the movement axis of the table.

A licensed physician may choose to use FDA-approved contrast agents in conjunction with an MRI exam, based on his/her medical opinion and discretion and in accordance with the instructions for use and indications for use supplied by the pharmaceutical manufacturer for the contrast agents.

For a description of measurement steps identical to the Angio Dot Engine workflow please follow the links in the table below:

<table>
<thead>
<tr>
<th>Measurement steps</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test bolus</td>
<td>(→ Page 57 Planning and measuring the test bolus)</td>
</tr>
<tr>
<td>Pre-contrast measurement</td>
<td>(→ Page 58 Planning the CE MRA measurements and measuring pre-contrast images)</td>
</tr>
<tr>
<td>Post-contrast measurement</td>
<td>(→ Page 61 Measuring post-contrast images)</td>
</tr>
<tr>
<td>Configuration of protocol steps</td>
<td>(→ Page 62 Configuring protocol steps (optional))</td>
</tr>
</tbody>
</table>

3.8.1 Measuring a large FoV localizer

The measurement range of the localizer shall cover the patient from the heart down to the feet, i.e., the largest FoVs relevant for this application.

- Load a TimCT Angio program into the measurement queue.
The large FoV localizer runs automatically. It can be viewed as it is acquiring the data in the Inline Display. When the measurement is complete, whole-body MPRs in all 3 orientations are displayed.

3.8.2 Measuring the vessel scout

✓ Large FoV localizer has been measured

✓ Vessel scout has been opened

1 Position the slices of the vessel scout on the whole-body images of the large FoV localizer.

2 Start the vessel scout measurement.

3.8.3 Bolus timing

The patient table starts moving after the first cycle of phase-encoding steps. This means that the bolus timing is relevant for the first part of the acquisition only.

To determine the transit time, you draw two regions of interest (ROI) in an artery and in a vein of the test bolus images. The signal-time curves for the arterial and venous phase are subsequently computed.

✓ Test bolus images have been measured

✓ Pre-contrast protocol has been opened

1 Scroll through the test bolus series and select a suitable image.

2 Draw an ROI by clicking on an artery.

3 Optional: Draw a second ROI by clicking on a vein.

The signal-time curves for the arterial and venous phase are computed and displayed. The center of k-space is displayed for the first cycle of phase-encoding steps. The rest of the acquisition time is represented in the hatched area.
Contrast-enhanced MR angiography measurements
3 Contrast-enhanced MR angiography measurements
4 Non-contrast-enhanced MR angiography measurements

4.1 General information 68
4.2 Performing a NATIVE SPACE examination of the peripheral vessels 76
4.3 Performing a NATIVE TrueFISP examination of the renal arteries 80
4.1 General information

4.1.1 Time-of-Flight (ToF) MR angiography

ToF techniques are based on unsaturated spins in blood flowing into stationary tissue which is saturated by repeated application of the excitation RF pulse of the sequence.

For a detailed description of the ToF technique, please refer to the MR Basic Manual Magnets, Flows, and Artifacts.

Optimal slice positioning

To ensure the time-of-flight effect, the excitation volume must be adjusted to the speed of replacement by fresh blood between the excitation pulse and the data acquisition. This means that the speed of replacement determines the measurement technique to be used.

3D single slab: A single 3D slab is ideal for higher velocities (e.g. carotid).

Saturation of the blood signal is lower with a smaller slab thickness. For this reason the slab thickness should be as small as possible, that is, adjusted to the vessel region to be examined.

3D multi-slab: At a medium replacement velocity (e.g. arteries), the vessel region to be examined is divided into several thin 3D slabs.

The individual 3D slabs have to mutually overlap to compensate for their non-rectangular excitation profiles.

2D slices: At very low replacement velocities, e.g. when displaying veins (sagittal sinus), a very thin excitation slab may lead to saturation. In these cases, 2D slices are used to cover the excitation volume.

Maximum inflow is ensured when the excitation volume is positioned at a right angle to the flow, that is, usually axially. The course of the vessel of interest in the slice is then as short as possible. For this reason, the slices/slabs should be positioned as perpendicularly as possible to the vessel.
Contrast optimization with TONE

Blood is excited several times while it flows through the 3D slab. During this time, the blood is becoming increasingly saturated and the blood signal shows a drop in intensity as the vessel courses farther into the slab. The drop in intensity is greater the slower the blood flows in the vessel.

**TONE technique:** The TONE technique corrects this saturation effect. The technique generates a relatively uniform signal distribution within the blood vessels of a 3D slab. To this end, the RF pulses are switched with a tilted slice profile (tilted, optimized, nonsaturating excitation). The tilt of the slice profile generates flip angles varying from slice to slice.

For unsaturated flow with inflow at one side of the slab, smaller flip angles are used. For partially saturated flow through the slab, the flip angles are larger.

**Variable flip angle:** The flip angle increase across the 3D slab is optimized for flow velocity and slab thickness. Larger flip angle variations are used for thicker 3D slabs and slower flow. For faster flow and thinner 3D slabs, smaller flip angle variations are used.

**Contrast optimization through Magnetization Transfer (MTC)**

Magnetization transfer (Magnetization Transfer Contrast, MTC) is an indirect form of saturation. The background signal from specific solid tissue, e.g. cerebral parenchyma, is reduced, while the signal from blood remains unchanged.

MTC is **not** useful in fatty regions, since fat does not show magnetization transfer and as a result would only increase the contrast of fat.

**Parameters under syngo**

**Flip angle:** For 3D ToF, the flip angle should be located in the center of the 3D slab between 15° and 25°.

- At 15°: The blood signal on the inflow side is relatively weak.
- At 25°: The fat signal on the outflow side is very strong. The same applies to flow saturation.

For 2D ToF, the flip angles range between 50° and 70°.
**TONEx ramp (3D only):** The form of the TONE pulses is to be adjusted to the blood flow. The slower the blood flows through a 3D slab, the steeper the tilt of the flip angle distribution has to be. This prevents saturation effects of the blood while flowing through a 3D slab. The protocol parameter provides the ratio of the respective flip angles at the two edges of the 3D slab in percent. The nominal flip angle in the protocol is the mean value of the two edge values and is applied in the center of the slab.

Example: Flip angle = 20°, TONE ramp = 60% result in an excitation profile with a flip angle that increases from 15° to 25° across the slab.

**Flow direction:** The flow direction determines the inflow side of the blood into the slab.

- For caudal flow: F>H
- For cranial flow: H>F

**Fat suppression:** The bright fat signal may interfere with post-processing (e.g. MIP). This occurs especially with slow flow.

For a good fat suppression, generally select an echo time where fat and water show opposed phases (1.5 T: approx. 3.6 ms; 3 T: approx. 7.2 ms).

For 2D ToF protocols, a frequency-selective saturation can be used to suppress signal from fat.

**ECG triggering with pulsatile flow**

Generally, the flow in arteries is not uniform, but more or less pulsatile. In the periphery this may lead to blood flowing back at the end of a cardiac cycle. Thus, the time that the blood remains in the slice fluctuates, and this causes a variation in the blood signal intensity during the measurement. This fluctuation in intensity leads to **pulsation artifacts** in the image.
Physio card: To avoid pulsation artifacts, it is useful to switch to ECG-triggered 2D ToF measurements. During these measurements acquisition is limited to the cardiac cycle which ensures maximum inflow into the slice.

Select the TR parameter for the duration of maximum inflow. TR should be filled with the maximum possible number of segments.

4.1.2 Phase-contrast MR angiography

Phase-contrast MRA uses the phenomenon of a flow-induced phase shift for selectively displaying flowing blood. The phase shift measured can be used for flow encoding in the image as well as for flow quantification.

For a detailed description of the phase-contrast technique, please refer to the MR Basic Manual Magnets, Flows, and Artifacts

Parameters under syngo

Velocity encoding: The Angio parameter card provides a choice of three independent velocity encodings. The Flow mode parameter provides you with a Free mode as well as two additional default values for standard measurements.

- Single direction: The leg vessels are frequently measured with velocity encodings H>>F at several different speeds. Due to the strongly pulsatile flow, triggering should be used for measurements.

- Single velocity: In the head region, only one velocity is encoded in all directions since the location and course of vessels is not uniform.

The number of encodings must fit into the TR interval. For this reason, it may be necessary to increase the TR interval in the Routine parameter card to allow for additional encodings.

PC MRA with ECG triggering

If the flow in a specific vessel varies greatly within the cardiac cycle, it is preferred to limit the measurement to a specific interval of the cardiac cycle to allow measuring a constant velocity.
Segmentation: To limit the measurement time, the measurement can be segmented. For example, you can select 5 or 7 phase-encoding lines per heart beat. To determine the ECG window, it is helpful to know the flow profile.

PC MRA with pulse triggering

You can use the pulse trigger for examinations of the torso. In this case, the measurement window has to be shifted to the end of the pulse period.

Appropriate setting of the trigger delay: When using the pulse sensor, the heart beat should be very regular since the time of triggering is determined by the previous pulse wave. ECG triggering, however, is measured directly in the pulse wave generated after the time of triggering. In this case, the heart beat can be more irregular.

When using triggered phase-contrast measurements, the pulse trigger cannot be used at the extremities (e.g., lower arm).

4.1.3 syngo NATIVE

syngo NATIVE is an MR angiography technique for visualizing the vessels of the body without the use of contrast agent. It is suited for patients with known allergies to contrast agents or renal dysfunction (risk for developing NFS).

Currently two techniques are available:

- syngo NATIVE SPACE: Optimized for peripheral regions (lower legs)
- syngo NATIVE TrueFISP: Optimized for the abdomen (renal arteries)

Principle of NATIVE SPACE

The NATIVE SPACE technique relies on the inherent difference in signal between fast flowing blood during the systole and slower flowing blood during diastole to generate contrast.
The principle of this technique is the exploitation of the flow void which occurs in spin echo type imaging with fast flowing blood. The signal returned from flowing blood in sequences using a TSE type readout will diminish as velocity increases. If a measurement is performed at the point in the cardiac cycle where arterial blood flow is maximal, arteries will show low signal. In a second data set that is acquired when arterial blood flow is slow, arteries will be bright. Veins, however, with inherently slower blood flow and less pulsatile nature, will be depicted with very similar high signal in both data sets. Hence, a subtraction of both data sets will provide an angiogram of the arterial vascularity.

Limitations: The technique relies on the pulsatile nature of blood flow. Therefore, intrinsic limitations are possible in lack of pulsatility (predominantly distal to severe pathology) or with an irregular heartbeat. In the presence of pathology, different timing may be required for the left and right leg. Additionally, the technique is susceptible to motion.

Principle of NATIVE TrueFISP

The intrinsic contrast is generated by the inflow of blood with non-inverted spins into an inverted imaging volume. The slice-selective inversion recovery (IR) pulse for preparing the imaging volume can be positioned graphically. To reduce respiratory artifacts, 1D PACE navigators, ECG triggering, or respiratory triggering are used.
(1) Inversion
(2) Inflow
(3) Imaging

Sequence of events for a renal study: During the inversion time, TI non-inverted blood flows into the imaging volume and gives rise to a signal similar to a normal TrueFISP signal—while stationary tissue and blood already in the slice exhibit a lower signal. (Illustrations courtesy of Gray’s Anatomy.)

<table>
<thead>
<tr>
<th>Mode</th>
<th>Typical application</th>
<th>Advantage</th>
<th>Disadvantage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Respiratory triggering/no</td>
<td>Renal or any abdominal/thoracic</td>
<td>Compatible with long TI of 1200–1400 ms to</td>
<td>In some cases less time efficient than 1D PACE. Lack of ECG triggering</td>
</tr>
<tr>
<td>ECG triggering</td>
<td>angiography.</td>
<td>ensure sufficient inflow.</td>
<td>requires longer TI to guarantee inflow for every TI period.</td>
</tr>
<tr>
<td></td>
<td>Examination of patients with low</td>
<td>No residual saturation from navigator.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>cardiac output and/or poor flow</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>conditions.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Possible combinations of respiratory and cardiac synchronization modes

**Limitations:** NATIVE TrueFISP is a flow-dependent technique. Total blood available for imaging is proportional to the stroke volume of the patient. Such a flow-dependent technique is therefore challenging when the stroke volume is low, e.g., in case of patients with poor cardiac output, or when the flow in the vessel of interest is low. Optimization in these cases requires extending the TI. However, the measurement time and the background signal intensity are increased.
4.2 Performing a NATIVE SPACE examination of the peripheral vessels

The NATIVE SPACE technique can be used for single-station or multi-station MRA examinations. In the following, a single-station examination is described.

4.2.1 Determining the trigger times

✓ ECG electrodes/pulse sensor have been attached to the patient (→ Page 21 Attaching ECG electrodes)
✓ NATIVE SPACE measurement program has been selected
✓ Multi-planar localizer has been measured
✓ CINE TD scout has been opened
◆ Position the CINE TD scout on an artery within the imaging volume so that the slice is perpendicular to the vessel of interest.

Setting the timing parameters

1. Open the Physio Signal1 parameter card.

2. Check the correct trigger source.

3. Ensure that TR is minimized and adapt the number of measurements to the cardiac cycle by clicking Captured cycle.
Performing the measurement

1. Start the measurement.
   A series of single-slice images in various cardiac phases is acquired.

2. Drag the images into a GSP segment.

3. Scroll through the series and determine the image with a high arterial signal intensity.

For a more comprehensive analysis, you may also use an ROI evaluation of the CINE series with Mean Curve.

CINE TD scout data evaluation in the Mean Curve taskcard.

Typical TD values that provide good results:
- $TD_{MinFlow} = 0$ ms
- $TD_{PeakFlow} = (TT_{MeanCurve} - 30)$ ms

4.2.2 Using TD scout alternatives (optional)

Two additional TD scout protocols are possible:
- NATIVE TD scout
- Flow TD scout

The Flow TD scout is a standard retro-gated through-plane flow quantification protocol. For obtaining quantitative flow values, you can evaluate the data in Argus. However, extra licenses are required for both the sequence and Argus.
Using the NATIVE TD scout

Within the NATIVE sequence, a TD scout mode is available which can be activated with the NATIVE mode selection box on the Physio Signal1 parameter card. In this mode, a series of thick-slab projection images with different trigger delays is acquired from the slab of interest. The timing can be adjusted with the two parameters TD first and TD increment.

Advantage: Coverage of a complete coronal FoV is possible

Disadvantages:
- If TR is too large (not minimized), only a few measurements may fit into one cardiac cycle.
- If the standard inline subtraction is activated, the first image is subtracted from all subsequent ones. Therefore, it may be difficult to extract optimal trigger delay values from the resultant image series.
- If one or several trigger pulses are left out during acquisition (bad ECG signal, irregular heartbeat), the background signal of the resulting series may vary significantly. Therefore, it may be difficult to extract optimal trigger delay values from the resultant image series.

In the Physio Signal1 parameter card:

1. Enter the start value for the trigger times (TD first).
2. Enter the time interval for the trigger times (TD increment).

After the measurement:
3. Drag the images into a GSP segment.
4. Determine the TD times of the two images with brightest and darkest arteries.

Typical TD values that provide good results:
- TD_{MinFlow} = 0 ms
- TD_{PeakFlow} = 300 ms
4.2.3 Measuring NATIVE images

You acquire two ECG-triggered data sets (systole and diastole). The resulting images are computed via Inline subtraction.

✓ Trigger times have been determined
✓ NATIVE 3D protocol has been opened

1 Open the Physio Signal1 parameter card.

2 Enter the trigger time for the systolic phase with fast arterial blood flow (TD peak flow).

3 Enter the trigger time for the diastolic phase with slow arterial blood flow (TD min flow).

4 Start the measurement.

The arterial angiogram is provided by Inline subtraction of the two measurements.

The quality of the angiogram may depend on the blood flow conditions. To optimize the angiogram, you can adapt the flow sensitivity on the Physio Signal1 parameter card (low, medium, and high).
4.3 Performing a NATIVE TrueFISP examination of the renal arteries

To perform a respiratory-triggered examination, you use the respiratory belt. Each respiratory cycle triggers the acquisition of a data shot. A long TI of 1200 ms–1400 ms should be used to ensure sufficient inflow.

To ensure good respiratory monitoring, attach the respiratory belt tightly around the abdomen. For a detailed description of respiratory triggering, please refer to the Operator Manual - MR System.

- Respiratory belt has been attached to the patient
  (→ Page 21 Attaching ECG electrodes)
- Localizer has been measured
- NATIVE TrueFISP measurement program has been opened

4.3.1 Planning the imaging volume and inversion band(s)

1. Position the slices and the first graphically positionable inversion band (= inversion pulse) over the kidneys.
2. Align the top of the graphically positionable inversion band with the top of the slice group.

Positioning of the imaging volume and the inversion pulse for a regular renal arteriogram.
When using long TI times (>1200 ms) for the inversion of the imaging volume, unsaturated venous blood might enter the imaging volume, for example, in the inferior vena cava. A saturation of such signal may be achieved by positioning one or more additional inversion band(s) (with shorter TI) inferior to the inversion of the imaging volume.

3 In order to increase the number of inversion pulses, open the Geometry Inversion parameter card.

4 Modify the number of inversion pulses and the corresponding inversion times (TI).

Positioning of additional inversion bands for improved suppression of venous signal.

4.3.2 Checking the respiratory signal

✓ Imaging volume has been planned

1 Open the Physio Signal parameter card.
2 Ensure that the acquisition is reliably positioned in expiration phase.

3 Start the measurement.

4 Monitor the respiratory signal and the adequate triggering during the measurement.

### 4.3.3 Alternative examination types

#### 1D PACE/ECG triggering

- In subjects with sufficiently high blood flow, use 1D PACE navigators in combination with ECG triggering and a short TI that fits into an acquisition window within one RR interval.

For a description of the navigator planning, please refer to the Operator Manual - Cardio.

#### 1D PACE/no ECG triggering

- Use a TI of approx. 35% more than the patient’s RR interval to increase the statistical probability of each TR incorporating at least one systolic event.
Free breathing

In cases where respiratory motion is negligible (e.g., patients with transplanted kidneys) you can perform the examination without PACE or respiratory triggering.

- Use a longer TI.
4 Non-contrast-enhanced MR angiography measurements
5 Flow measurements

5.1 Measuring the flow in the renal arteries
5.1 Measuring the flow in the renal arteries

To display flow and the encoding of the flow velocity, phase contrast images are used. (For a detailed description of the phase contrast technique, please refer to the MR Basic Manual Magnets, Flows, and Artifacts.) In what follows, the measurement of the blood flow in the renal arteries is introduced. The measurement is performed using the breathhold technique.

5.1.1 Measuring the localizers

✓ Flow measurement program has been selected

1 Measure a survey localizer.

2 Acquire coronal images of the entire kidney (e.g. 15 slices).

3 Generate a 3D angiography data set of the bifurcation of the renal artery by using the NATIVE TrueFISP method or a 3D ToF sequence.

Positioning the 3D slab on the angiography images (here acquired with a ToF sequence).

5.1.2 Determining the slice position

✓ Localizers have been measured

1 Load the localizer images into the 3D task card.

2 Position the slice to be measured on the orthogonal slices.
The measurement slice must run vertical to the renal artery. Position the slice on a straight section of the artery approximately 15 mm (0.6 inch) away from the aorta.

3 Store the images.
4 Load an image of the stored 3D series to the Examination task card.
5 Accept the slice position of the image from the 3D series.
6 Select the correctly positioned slice and select Tools > Copy Image Position.

5.1.3 Determining the flow sensitivity
To obtain the optimal measurement result, proceed by first determining the area of maximum flow velocity.

✓ Measurement slice has been determined
1 Adjust the FoV to the requested image section.
2 On the Physio Signal1 parameter card: Adjust the target RR to the average cycle.
3 On the Angio Common parameter card: Set the velocity encoding to 100 cm/s.
4 Start the measurement of the velocity localizer.
5 Load the image series into Argus and read the maximum velocity.
6 Calculate the optimal area of flow sensitivity.
Performing the measurement

✓ Flow sensitivity has been determined

1 Check the FoV.

2 On the Physio Signal1 parameter card: Accept the average heart cycle for the acquisition window.

3 On the Angio Common parameter card: Enter the computed venc into the velocity encoding window.

4 Ensure that Through Plane is entered in the direction window.

5 Activate the checkbox of the image series you would like to save.

6 Enter the breathhold command and start the measurement.

7 After completing the measurement, enter the command for breathing.

Flow-compensated, flow-encoded, and phase-contrast image of the renal artery (arrow).
# 6 Post-processing

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.1 Statistical evaluation with Mean Curve</td>
<td>90</td>
</tr>
<tr>
<td>6.2 Vessel analysis with Vessel View</td>
<td>97</td>
</tr>
<tr>
<td>6.3 Flow analysis with Argus</td>
<td>109</td>
</tr>
</tbody>
</table>
6.1 **Statistical evaluation with Mean Curve**

Statistical evaluation with **Mean Curve** provides information about signal changes as a function of time and place. The resulting curve plots the mean grayscale value against a selectable second variable (X-axis).

The following example describes how to examine the change of the average grayscale value in a region of interest (ROI) depending on slice position, trigger time, or image number.

6.1.1 **Preparing the data**

**Loading the image data**

- MR measurement series or post-processing series (dynamic analysis, MIP/MPR) are available. All series have the same orientation and spatial resolution.

1. Select the image data in the **Patient Browser**.
2. Transfer the data with **Applications > Mean Curve** to the **Mean Curve** task card.

All images are stacked in the 1st segment (evaluation segment). Sorting is applied **within** each series and **across** multiple series according to initial sort criteria. Image display and evaluation modes are set automatically:

<table>
<thead>
<tr>
<th>One series loaded: evaluation mode <strong>within series</strong>.</th>
</tr>
</thead>
<tbody>
<tr>
<td>The middle image (acc. to <strong>within</strong> sort criterion) of the stack is displayed.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Multiple series loaded: evaluation mode <strong>across series</strong>.</th>
</tr>
</thead>
<tbody>
<tr>
<td>The middle image (acc. to <strong>within</strong> sort criterion) of the middle series (acc. to <strong>across</strong> sort criterion) is displayed.</td>
</tr>
</tbody>
</table>

**Loading images for evaluation**

1. Select the image data in the **Patient Browser**.
2. Transfer the data with **Applications > Mean Curve** to the **Mean Curve** task card.

All images are stacked in the 1st segment (evaluation segment). Sorting is applied **within** each series and **across** multiple series according to initial sort criteria. Image display and evaluation modes are set automatically:

**Loading images to support evaluation (optional)**

1. To facilitate contour determination of the evaluation region, drag & drop suitable images into the 3rd segment.

The image with the same value of the **within** sort criterion as the image in the 1st segment is displayed.
You may load, for example, the subtraction series or the MIP series. The images must have the same orientation and spatial resolution as the images in the 1st segment.

2 To facilitate localization of the evaluation region, drag & drop suitable images into the 4th segment.

You may load, for example, reference images of the exam or images showing the relevant region in a different orientation.

3 To move images into a different segment, reload them via drag & drop.

Optimizing the image display

1 Zoom/pan the images or invert the grayscale values with the corresponding entries in the Image menu.

2 Window the images to optimize their contrast and brightness.

Determining the sorting for evaluation

By selecting the sort criteria, you establish the scrolling sequence in the first and third segments and define the X-axis parameter of the evaluation.

Possible applications of time-related sorting criteria:

- **Trigger Time**: physiologically triggered measurements, e.g. cardiac series
- **Echo Time**: multi-echo sequences, e.g. multi-echo spin-echo sequences
- **Normal Time**: dynamic and/or motion studies

The current sort criterion is displayed in the control area.

1 Open the Scaling dialog window with the icon on the Tools subtask card.

2 To select the sort criteria in the within series mode, use the X-axis tab card.
– or –

To select the sort criteria in the **across series** mode, use the **Sort** tab card.

In the **across series** mode, the multiple series are sorted via the sort criterion of the X-axis (**across**). The images within each series are sorted according to the **within** sort criterion.

### 6.1.2 Defining the evaluation region

You define the regions for statistical evaluation by drawing ROIs in a suitable starting image in the 1st or 3rd segment. The ROIs are then propagated to the other images.

**Searching an image for ROI positioning**

- Display the evaluation region by scrolling in the 1st or 3rd segment.

  Upon scrolling in one segment, the other segment displays the image with the same value of the **within** sort criterion.

The **across** sort criterion is considered when scrolling from series to series in the 1st segment. The image with the same value of the **within** sort criterion is displayed. If no such image is found, the corresponding series will be skipped.

– or –

Navigate to a suitable image by moving the cut line in the reference image (4th segment).

The 1st and the 3rd segments display the images with positions that best match the position of the cut line.
Drawing ROIs

All tools for ROI definition are available on the **Tools** subtask card.

- Draw up to four ROIs in the starting image in the 1st or 3rd segment.

The ROIs of the first segment are displayed automatically in the third segment and vice versa.

(1) ROIs in 1st segment

(2) ROIs in 3rd segment

If the slice positions in the segments differ, the ROIs in the 3rd segment are displayed in white with a solid line.
Adapting and propagating ROIs

ROIs are propagated to the images displayed during scrolling or to images that are not displayed when starting the evaluation. As the default setting, any change of an ROI in one image is reproduced in the other images involved (Static ROI mode).

1. To enable individual ROI modification, activate the Dynamic ROI mode with the icon.

2. Scroll through the images in the 1st or 3rd segment and check if the ROIs match the anatomy to be evaluated.

3. Correct the size and position of the ROIs, if necessary.
   
   If the Static ROI mode is activated, the (modified) ROIs are propagated to all other images. Already existing ROIs are overwritten.

   If the Dynamic ROI mode is activated, the (modified) ROIs are propagated to the images in the scrolling direction. Already existing ROIs remain unchanged.

You can remove a ROI with the Del key. The ROI is deleted in all images regardless of the active ROI mode.

6.1.3 Performing the evaluation

The following modes can be selected for evaluation:

- **Absolute** evaluation (default setting): The signal intensity in the ROIs is assigned to the Y-axis.

- **Relative** evaluation: The difference between the signal intensity and a reference value as well as the ratio of the difference to the reference value are assigned to the Y-axis.

Relative evaluation is used, for example, to evaluate the change of signal intensity in contrast-phase images with respect to the pre-contrast images.
Switching to relative evaluation

1. Select the **Relative** evaluation mode with the icon on the **Tools** subtask card.
2. Select the reference image (**within** mode) or the reference series (**across** mode) in the dialog window displayed.
3. To exclude the reference image or series from evaluation, uncheck the corresponding checkbox.

Starting evaluation

1. Click the icon on the **Tools** subtask card.
   The resulting diagram shows a curve for each ROI in the color and line style of the corresponding ROIs. A table is generated for each diagram.
2. To display the intensity of the signal for a defined X-value, move the vertical measurement line.
   
   - If the vertical line is not visible, it is superimposed directly onto the Y-axis.
3. To smooth the curve, click the icon on the **Tools** subtask card.
4. Edit the commentary line with a double-click, if necessary.
The results will be rejected if you add or delete images, manipulate ROIs, or change the sort criterion. Subsequent recalculation can be performed automatically if Tools > Auto Recalculation is selected. If you have loaded a large number of series, however, you should deselect this option to save time.

Optimizing the result display by scaling

Scaling the axes

Manual scaling helps you to adjust the graduation of the axes more accurately to the region of interest.

1. Open the Scaling dialog window with the icon on the Tools subtask card.
2. Set the boundaries of the X and Y-axes in the respective tab cards.

If the Relative mode is activated for evaluation, the tab cards Y-axis (diff) and Y-axis (norm) are displayed for scaling the Y-axes.

3. Subdivide the Y-axis linearly or logarithmically with the Scale parameter of the Y-axis tab card.

   Automatic Scaling is disabled. The manual scaling that has been set applies to all subsequent evaluations.

Scaling the grayscale values

Scaling the measured grayscale values is useful if the grayscale values are proportional to a physiologically relevant value and the proportionality factor is known (e.g., flow velocity of the blood).

- Set the scaling parameters for grayscale values in the Y-axis tab card of the Scaling dialog window.

Example: Factor = 2, Offset = 20

All Y-values will be multiplied by 2 and shifted 20 units toward the positive Y-axis.

Automatic Scaling is disabled. The manual scaling that has been set applies to all subsequent evaluations.
6.1.4 Documenting the results

Setting the background image for diagrams

1. If necessary, adjust the contrast and brightness in the 1st segment for an optimally visible curve.

2. To use the current image in the 1st segment as the background, select the View > Image with Graphics option.

You can reset a black background using the View > Graphics only option.

Reporting the results

✓ Evaluation results are displayed in the 2nd segment

The report includes all evaluation results. It is stored in DICOM format in its own series (the report name is derived from the name of the current series). The Report Editor in the Patient Browser must be used for further processing.

1. To create a report, click the icon.

2. To add report data for additional evaluations, click the icon.

Use this function, for example, when you have drawn and evaluated new ROIs.

6.2 Vessel analysis with Vessel View

Contrast-agent measurements of the vascular system visualizes geometric characteristics of the vessels. Vessel View is used for preparing, detecting, and evaluating stenoses in the course of the vessel analysis.
6.2.1 Preparing the data

Loading the image data

✓ Contrast images have been acquired along one axis
✓ Each image has a different slice position with a distance between two adjacent slices less than 2 times the average slice distance
✓ All images have been taken within a period of 30 minutes

1 Select the data series to be analyzed in the Patient Browser.
2 Transfer the data to the Vessel View task card.

(1) Slice image segments (MPR, MPR thick slice display, MIP or MIP thin slice display)
(2) Volume image segment (VRT or MIP display)
(3) Control area
(4) Evaluation area with Measurements and Vessel Navigator subtask cards

Optimizing the image display

You can use the Configure menu to define which additional elements are displayed in the image segments.
Adjusting the image views

1. Select an image segment and resize it, if necessary.

2. Adjust the image orientation by using the reference lines and the Orientation subtask card.

3. To display the relevant image area, zoom and pan the image.

4. Window the images to optimize their contrast and brightness.

Adjusting the VRT display

1. To visualize vessels in the volume image, open the VRT Gallery (right-click the icon).

2. Select a suitable VRT parameter set.
   The VRT volume image is displayed including the respective tissue class parameters of the selected parameter set.

You can change individual VRT parameters on the VRT Definition subtask card.
3 Rotate the volume with the orientation cube.

4 To set the volume image to one of the standard view directions, click the corresponding side of the orientation cube.

A double-click anywhere in the orientation cube sets the volume image to front view and original size.

6.2.2 Defining the vessel

Semi-automatic path creation is used to define individual vessels. Based on seed points placed inside the vessel, a segmentation algorithm automatically finds the vessel limits.

All paths created during a session are entered in the object list in the Measurements subtask card. With the object list you can manage the paths (e.g., rename, delete, or merge paths).

You can hide interfering vessels using Artery Vein Separation or cut them out as tube-shaped VOIs.

Creating the paths semi-automatically

1 Open the Semi Automatic Path Creation dialog window with the icon.

2 Set one seed point each at the beginning and end of the vessel section.

3 To identify branched vessels, position a seed point for each vessel where the vessels join.

4 Start the segmentation with Start.

The vessel center line (path) is displayed in the volume image segment.

The Translucent mode is active (85% transparency) to improve visibility of the paths. They are no longer hidden by the surrounding contrast agent.

5 Check to ensure that the path runs in the center of the vessel.
6 If necessary, activate the **Path Editing** mode in the **Segmentation** subtask card to correct the path.

7 To create the path for additional vessels follow the same procedure.

8 Use the fader on the **Segmentation** subtask card to change the visibility of the hidden volume parts.

**Separating the arteries from the veins**

Depending on the contrast agent or the timing of contrast administration, both the arteries and the veins could be visible. In this case you can use **Artery Vein Separation** to visually separate them.

---

**Setting of seed points for artery and vein definition is possible only in the axial slices.**

1 Open the **Artery Vein Separation** dialog window with the icon. The axial image segment becomes the large image segment.

2 Activate artery definition and set one seed point each at the beginning and end of the artery.

3 Activate vein definition and set one seed point each at the beginning and end of the vein.

4 Set additional pairs in places where arteries and veins lie very close together.

5 Start the segmentation with **Start**.
The arteries are shown in red and the veins in blue.

Select the desired display mode in the selection list of the **Segmentation** subtask card.

Visibility of veins or arteries in the volume display can be suppressed or reduced by the fader.

**Removing interfering vessels**

In general, you cut out a vessel as a tube-shaped VOI using a manually created path.

**Creating paths manually**

1. Open the **Manual Path Creation** dialog window with the icon.
2. Set control points at the beginning, at the end, and at any change of direction of the vessel.

   - The control points should be as close as possible to the center of the vessel. If necessary, correct the path subsequently with the mouse in the **Path Editing** mode.

3. Start calculation of a smoothed connection line with **Apply**.

**Cutting out the vessel tube**

1. Select the path in the object list or in the volume image.
2. Start VOI calculation with the icon of the **VOI** subtask card.
The vessel tube is shown in the volume image.
The radius of the vessel tube is freely selectable between 0 mm and 50 mm in the VOI subtask card.

3. To remove the vessel tube, click the icon.

6.2.3 Analyzing the vessel
Vessel evaluation is performed with the Vessel Navigator subtask card. It displays the vessel as a flat ribbon to provide an overview.

(1) Stenosis curve (overview of the vessel cross-section)
(2) Flat-ribbon MPR image
(3) Marker flags for stenosis evaluation: Normal (blue, for comparison), Minimum (red, possible stenosis)
(4) Focus pointer for navigating along the path

During evaluation, you can toggle between the flat-ribbon display (standard) and the curved MPR display with the icon on the Type subtask card.
Displaying the vessel in the Vessel Navigator

1. Select the path of the vessel from the object list or the volume image.

2. To display the flat ribbon MPR, click the Vessel Navigator subtask card.

3. Set a suitable ribbon width with the corresponding entry in the context menu of the Vessel Navigator.
   Depending on the new setting, the flat ribbon MPR contains either more or less vessel environment.

4. Rotate the view about the vessel axis by dragging the mouse perpendicular to the axis.

Inspecting the vessel

1. Adapt the display of the stenosis curves with the Configure > Vessel Navigator Curves submenu entries.

   - **Surface** displays the curve of the cross-sectional surfaces along the vessel.
   - **Diameter** displays the maximum (top), equivalent (center), and minimum (bottom) diameter curve.

2. Activate the orthogonal vessel orientation in the slice segments with the icon on the Orientation subtask card.

3. Navigate along the vessel path using the focus pointer.
   The image in the lower slice segment shows the vessel cross-section and the vessel contour at the path position.

Evaluating stenoses

You evaluate a stenosis by comparing the cross-sectional area of the vessel within and behind suspicious positions along the path.

The Vessel Navigator automatically calculates suitable measurement points for stenosis evaluation and marks them with flags.
Caution

Ambiguous marking of vessel contour and flag positioning!

Incorrect vascular analysis
- Ensure that the contours are drawn correctly in the image prior to confirming a measurement or flag.
- Ensure that the flag is positioned correctly in the image prior to confirming a measurement.
- Ensure that a stenotic flag is always positioned in the area of maximum vascular stenosis.

✓ Vessels have been defined (segmented)

1 To compare a stenosis with two healthy vessel locations, select Three flags in the context menu of the Vessel Navigator.

2 Reposition the Minimum flag with the mouse according to the results of the vessel inspection, if necessary.

3 Check if the drawn contour in the axial image matches the cross-section of the vessel.

4 To correct the contour, activate the contour editing mode in the Meas... subtask card.

5 Accept the contour with the icon.

6 Check the position of the associated Normal flags and correct/accept the contours in the axial images.
The cross-sectional area at the Minimum and Normal flag positions is compared. When you use two Normal flags, the degree of stenosis is calculated using the average of the two comparison measurements.

The result is shown as the degree of a potential stenosis in the object list and in the volume display. The value ranges between 0% (vessel potentially not constricted) and 100% (vessel potentially fully constricted).

Measuring the vessel geometries

1. Activate the required measurement tool in the Meas... subtask card.
2. Perform the measurement in the volume image or in one of the slice image segments.
   Completed measurements are recorded in the object list of the Measurement subtask card.

A number of evaluations can be performed in the orthogonal vessel orientation only.

Sending the image data to the GSP

You can immediately start plaque or flow measurements at the location of the stenosis by transferring the corresponding image to the GSP. Initial planning, orienting, and positioning of the slice is not necessary.

1. Select the slice image segment with the image data for graphical slice positioning.
2. Transfer the coordinates to the GSP with Send to GSP in the context menu.
   The coordinates transferred to the GSP of the Exam task card are automatically used for the slice to be measured.
6.2.4 Documenting the results

Documenting the vessel properties

The vessel properties of a designated stenosis are required for the report in the DICOM format.

1. In the object list: Open the Vessel Properties for Ratio dialog window by right-clicking the degree of stenosis.

2. Select the applicable entries in the selection lists and confirm with OK.

   Selection of an entry determines the content for the subsequent selection lists.

Documenting the axial cuts of the vessel

1. Select the path of the vessel from the object list or the volume image.

2. Open the Axial Cuts dialog window with the icon in the lower section of the control area.

   A symbolic preview of the image series is shown in the image volume.

3. Set the series parameters and start calculation with Start.
A series of axial MPR section images is generated and stored in the database.

**Saving and filming the results**

**Saving the session**
1. Open the **Save Session** dialog window with **File > Save Session**.
2. Enter a name and store the session in the local database with **Save**.
   
   You can restore the session at any time with **File > Load Session**.

**Saving the path**
You can save the path data in a format that can be read by the **3D** task card and displayed with the **3D Fly** function.
1. Select the path of the vessel from the object list or the volume image.
2. Store the path data in the database with **Send Path to 3D Fly** in the context menu.

**Saving the rotation about an axis**
You can save the image sequence of an automatic 360° rotation as a new series to the database or as an avi movie file. The avi file can be replayed on other systems using any multimedia software.
1. To record rotation about the vessel axis, select the **Vessel Navigator** image segment.
   
   – or –
   
   To record rotation about the vertical axis, select the volume segment.
2. Open the **Save As** dialog window with the icon for entering the storage parameter.

   The storage format is selectable in the **Save As** selection list.

   With the slider, you can set a maximum number of 72 images. This results in the smallest possible difference in viewing angles (5°) of images in sequential order.

3. Save the image sequence with **Save**.
Reporting the results

✓ Vessel properties have been documented for stenoses

The report includes all measurements. It is stored in the DICOM format in its own series (VesselViewMR_SR <time stamp>). The Report Editor in the Patient Browser must be used for further processing.

1 To create the report, click the icon.

2 To add an image, select the corresponding segment and click the icon.

Manually added images cannot be linked to measurements.

6.3 Flow analysis with Argus

Flow analysis is used to determine the mean and maximum velocity of blood flow and the vessel cross-sections depending on the trigger time.

The following example describes how to perform flow analysis of through-plane data for the ascending and descending aorta. As the analysis for in-plane data is largely the same, it is not described in what follows.

Please note that it is not possible to simultaneously process through-plane and in-plane data within the Argus flow analysis.
6.3.1 Preparing the data

Loading the image data

✓ Phase-contrast images and corresponding rephased images are available

1 Select the data series to be analyzed in the Patient Browser (use the Ctrl key for multi-selection).

You may also select magnitude images for loading as additional data.

2 Transfer the data to the Argus task card by clicking the Argus icon.
   The Argus task card opens in the Argus Viewer mode.

3 Start flow analysis by clicking the icon.
   The image matrix is rearranged:
   - Images in a row are from the same image reconstruction type.
   - Images in a column are from the same cardiac phase.
Optimizing the image display

1. Enlarge the image area showing the ascending and descending aorta.

2. Window the images to optimize their contrast and brightness.

   The grayscale values of the phase-contrast images represent flow velocities.
If necessary, you can assign a linear color scale instead of the grayscale in the Color selection list of the View subtask card.

Example: Assignment of the **Red to Blue** color scale.

You cannot window phase-contrast images in color. However, you can continue to use zooming and panning.

6.3.2 **Defining the evaluation regions**

You draw the contours of the vessel cross-sections to define the ROIs for flow analysis.

All tools for ROI definition are available on the **Drawing** subtask card.

You can draw ROIs into any image. Later during propagation, they are copied automatically to the images belonging to the same phase.

The rephased images show the edges of the vessels more clearly than the phase-contrast images. This makes them especially suitable for drawing.
Drawing the ROI for the ascending aorta
✓ R1 icon for drawing the 1st ROI is active
1 Load an image containing easily recognizable vessel cross-sections into a work segment.
2 Draw a circular ROI around the cross section of the ascending aorta.
3 Fit the ROI to the vessel contours of the ascending aorta by clicking the icon.

Once the ROI is drawn, the result of the statistical evaluation is shown next to it.
The value of the highest flow velocity in the ROI is marked by a point in the image.

Drawing the ROI for the descending aorta
1 To start drawing the second ROI, click the R2 icon.
2 Draw a circular ROI around the cross section of the descending aorta.
3 Fit the ROI to the vessel contours of the descending aorta by clicking the icon.

Analyzing low velocities (optional)
When analyzing low velocities you have to define a reference ROI.
1 Start drawing the reference ROI by clicking the Ref. icon.
2 Draw a small reference ROI in an area with stationary tissue near the vessel of interest (e.g., in the chest wall or the spine).
The flow parameters of the reference ROI are used for subsequent baseline correction.

Please note that if the background signal in the reference region differs significantly from the vessel region, the correction by the reference ROI might not be valid!

Propagating the vessel contours to other cardiac phases

During propagation, the contours of the ROIs are fitted to the anatomy. The contour of the reference ROI is copied without fitting.

1. Select all vessel cross-section ROIs that were drawn by clicking the icon.
2. Start the propagation by clicking the icon.
3. Select the reference ROI with the Ref. icon.
4. Copy the reference ROI by clicking the icon.

The ROIs are drawn into the remaining images of the matrix row.

Confirming the propagated vessel contours

Checking the ROIs
- View the images in a work segment one by one by scrolling through them with the arrow keys of the keyboard.
  - or –
  Display the images using the movie display function of the View subtask card with Graphics On.

Correcting the ROIs
If ROIs are misaligned, you correct them with the drawing and editing tools.

1. Change the size and the position of the ROI with the Move tool.
2 Correct the shape of the ROI with the **Nudge** tool.

3 Redraw a segment of the ROI with the **Splice** tool.

4 To apply the correction to the other series of this phase, browse through the images with the arrow keys or click the icon on the **Drawing** subtask card.

**Confirming the ROIs**

If propagated ROIs are not explicitly confirmed, a warning will be displayed in the results of the flow analysis.

- Accept the contours by clicking the icon.

### 6.3.3 Evaluating the vessels

All tools for evaluation are available on the **Result** subtask card.

You can graph the following parameters as a function of time:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Velocity</strong></td>
<td>Mean velocity within the ROI</td>
</tr>
<tr>
<td><strong>Peak Velocity</strong></td>
<td>Peak velocity within the ROI</td>
</tr>
<tr>
<td><strong>Flow</strong></td>
<td>Product of mean velocity and surface area</td>
</tr>
<tr>
<td><strong>Net Flow</strong></td>
<td>Difference between forward and return flow</td>
</tr>
<tr>
<td><strong>Area</strong></td>
<td>Cross-section of the vessel</td>
</tr>
</tbody>
</table>

During the analysis of in-plane data, it is physically not useful to compute the (net) flow because the vessels are merely truncated. As a result, it is not possible to reliably determine the blood flow through the vessel. For this reason, only the velocity as well as the cross-sectional area of the ROI are determined with in-plane data.
Calculating results with standard settings

If the patient data are incomplete, the Patient Information dialog window is displayed when starting the calculation.

1. Select the vessels with the R1, R2, and Ref. icons.
2. Start the calculation by clicking the respective parameter icon.
   The results for each ROI are displayed in graphic format.
3. To smooth the curve characteristic using a spline function, select Flow Options > Fit Curve as Cubic Spline.
   The spline curve is displayed in the graph as a dotted line.
4. Display the result tables by clicking Summary.

Limiting the time range
By default, the time between the first and last trigger time is used for evaluation.
1. Change the time range by overwriting the start and end values in the Result subtask card.
2. Start the recalculation with the Enter key.
Performing baseline correction

✓ Reference ROI has been defined

◆ Apply baseline correction with Flow Options > Use Baseline Correction.

A baseline is calculated from the flow parameters of the reference ROI and subtracted from the result curve.

Baseline correction is indicated in both the image text and the result tables.

Correcting phase aliasing

Flow velocities that exceed the defined flow sensitivity are shown with an incorrect grey value, resulting in phase aliasing. An exceedingly high positive velocity is shown as a high negative flow velocity (black) and vice versa (“phase reversals”).

Phase aliasing can be corrected, as long as the maximum flow velocity does not exceed double the value set as flow sensitivity during the measurement.

Examples:

(1) Blood flowing too fast causes dark spots in the region of the ascending aorta and bright spots in the region of the descending aorta.

(2) Phase reversals can be identified by the local minimum in the systolic phase. The highest velocities are much smaller than expected.
Caution

Incorrect selection of the range of velocity for a specific organ (preset range of velocity is lower than physiological range of velocity)!

**Incorrect flow and volume values**
- Correct the parameter range for the organ to be examined.

Applying correction

You adjust the curves by retroactively changing the velocity range (flow sensitivity) which is set to symmetrical by default.

1. Open the Venc Adjustment dialog window with the corresponding button.
2. Change the velocity range numerically or with the scroll bar.
3. Confirm the new velocity encoding with Update Results.

The actual flow velocity cannot be determined with this correction. It would require a new measurement.
A
Angio Dot Engine
Refer to Dot Engine 55
Argus flow analysis 109
Analyzing low velocities 113
Ascending aorta 113
Calculating results 116
Confirming contours 114
Correcting phase aliasing 117
Correcting ROIs 114
Defining evaluation regions 112
Descending aorta 113
Drawing ROIs 113, 113, 113
Evaluating vessels 115
Limiting the time range 116
Loading images 110
Optimizing image display 111
Performing baseline correction 117
Propagating vessel contours 114

B
Bolus timing
TimCT Angio Dot Engine 64

C
CA
Preparing the injection 18
CA injection
Timing 24
Care Bolus
Measuring the bolus 42
Care Bolus CE MRA
Measuring post-contrast images 42
Measuring pre-contrast images 40
Performing 40
Positioning the Care Bolus slice 41
Vein enhancement 41
Care Bolus slice 41
Multi-station CE MRA (single-injecton) 49
CE MRA

D
Data acquisition window 25
Dot add-in
Bolus Timing 62
Dot Engine 55
Configuring protocol steps 62
Determining the transit time 58
Examination strategy 55
Measuring post-contrast images 61
Measuring pre-contrast images 58
Positioning slices 60
Setting timing parameters 60
Test bolus 57
Dynamic CE MRA
Refer to TWIST 25

E
ECG triggering
PC MRA 71
ToF MRA 70
Electrodes
Attaching 21
Positioning 20
Procurement addresses 22
Examination strategy
Dot Engine 55

F
First injection
Multi-station CE MRA (double-injecton) 53
Flow analysis with argus
Refer to Argus flow analysis 109
Flow measurements
Determining the flow sensitivity 87
Determining the slice position 86
Measuring localizers 86
Performing 88
Renal arteries 86
Flow sensitivity 87

I
Imaging volume
NATIVE TrueFISP 80
Inline post-processing
CE MRA 35
Inline subtraction
CE MRA 31
Inversion bands
NATIVE TrueFISP 80

L
Large FoV localizer
TimCT angiography 63
Localizer
Flow measurements 86
Multi-station CE MRA (double-injecton) 51
Multi-station CE MRA (single-injecton) 47

M
Magnetization Transfer
Refer to MTC 69
Mean Curve
Adapting ROIs 94
Defining the evaluation region 92
Determining the sorting 91
Drawing ROIs 93
Loading images 90
Optimizing image display 91
Performing the evaluation 94
Propagating ROIs 94
Starting the measurement 49

N
NATIVE SPACE
Determining the trigger times 76
Performing the measurement 79
Principle 72
TD Scout 77
NATIVE TrueFISP
Checking the respiratory signal 81
Planning the imaging volume 80
Planning the inversion bands 80
Principle 73

P
Parameters
CE MRA 29
ToF MRA 69
TWIST 26
Patient
Positioning 18
Preparing 18
Patient positioning
Multi-station CE MRA (double-injection) 19
Multi-station CE MRA (single-injection) 18
PC MRA 71
ECG triggering 71
Parameters 71
Pulse triggering 72
Velocity encoding 71
PERU
Positioning 20
Phase-contrast MR angiography
Refer to PC MRA 71
Positioning
Electrodes 20
PERU 20
Positioning the patient 18
Post-contrast images
Care Bolus CE MRA 42
Dot Engine 61
Multi-station CE MRA (double-injecton) 53
Multi-station CE MRA (single-injecton) 50
Test bolus CE MRA 38
TWIST 46
Pre-contrast images
Care Bolus CE MRA 40
Dot Engine 58
Multi-station CE MRA (double-injection) 52
Multi-station CE MRA (single-injection) 47
Test bolus CE MRA 37
TWIST 46
Preparing the patient 18
Principle
TWIST 26
Procurement addresses
Electrodes 22
Protocol steps (Dot Engine)
Configuration 62
Pulsatile flow
ToF MRA 70
Pulse triggering
PC MRA 72

R
Renal arteries
Flow measurements 86
Respiratory signal
NATIVE TrueFISP 81

S
Second injection
Multi-station CE MRA (double-injection) 54
Single injection
Multi-station CE MRA 25
Slice positioning
Multi-station CE MRA (double-injection) 52
Multi-station CE MRA (single-injection) 48
ToF MRA 68
Statistical evaluation with Mean Curve
   Refer to Mean Curve 90
Strategy
   Dot Engine 55

T
TD Scout
   NATIVE SPACE 77
Temporal information
   TWIST 45
Test bolus
   Dot Engine 57
   Measuring 36
   Planning 36
Test bolus CE MRA
   Determining the transit time 37
   Measuring post-contrast images 38
   Measuring pre-contrast images 37
Test bolus CE MRA
   Performing 36
TimCT Angio Dot Engine 62
   Bolus timing 64
TimCT angiography
   Measuring a large FoV localizer 63
   Measuring the vessel scout 64
Time-of-Flight MR angiography
   Refer to ToF MRA 68
Timing parameters
   Dot Engine 60
ToF MRA 68
   Contrast optimization through MTC 69
   Contrast optimization with TONE 69
   ECG triggering 70
   Parameters 69
   Pulsatile flow 70
   Slice positioning 68
TONE 69
Transit time 24
   Dot Engine 58
Test bolus CE MRA 37
Trigger times
   NATIVE SPACE 76
TWIST
   Displaying temporal information 45
   Measuring post-contrast images 46
   Measuring pre-contrast images 46
   Parameters 26
   Performing the measurement 43
   Principle 26
   Setting dynamic parameters 44
TWIST protocols 43

V
Vein enhancement
   Care Bolus CE MRA 41
Velocity encoding 71
Vessel analysis with Vessel View
   Refer to Vessel View 97
Vessel scout
   TimCT angiography 64
Vessel View
   Analyzing vessels 103
   Axial cuts 107
   Creating the paths 100
   Defining the vessel 100
   Diameter of vessels 104
   Displaying vessels 104
   Evaluating stenoses 104
   Geometries of vessels 106
   Loading images 98
   Optimizing image display 98
   Removing vessels 102
   Rotation about the vessel axis 108
   Saving the path 108
   Saving the session 108
   Sending data to GSP 106
   Separating arteries from veins 101
   Surface of vessels 104
   Vessel Navigator 103
   Vessel properties 107
Manufacturer’s note:

This product bears a CE marking in accordance with the provisions of regulation 93/42/EEC of June 14, 1993 for medical products.

The CE marking applies only to medico-technical products/medical products introduced in connection with the above-mentioned comprehensive EC regulation.

Global Business Unit
Siemens AG
Medical Solutions
Magnetic Resonance
Henkestr. 127
DE-91052 Erlangen
Germany
Phone: +49913184-0
www.siemens.com/healthcare